Explode — Render — Animate application
Explode — Render — Animate application
Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2010 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

All trademarks belong to their respective holders.
## Contents

**Introduction** ........................................... 1-1

**Course Overview** ....................................... 2-1

**Rendering** ............................................. 3-1

- Working with advanced rendering .................. 3-1
- Perspective command ................................ 3-19
- Render Area command ................................. 3-19
- Render Scene command ................................ 3-19
- Activity: Rendering .................................. 3-20

**Defining motors** ..................................... 4-1

- Motor command ........................................ 4-1
- Simulate Motor command .............................. 4-4
- Motor Group Properties dialog box ............... 4-5
- Activity: Motor ....................................... 4-6

**Exploding assemblies** ................................. 5-1

- Automatic Explode command ........................ 5-1
- Edit Flow Lines command ............................ 5-5
- Flow Lines command .................................. 5-9
- Bind Subassembly command .......................... 5-9
- Unbind Subassembly command ...................... 5-10
- Explode command ...................................... 5-10
- Collapse command .................................... 5-12
- Explode PathFinder tab .............................. 5-12
- Display Configurations command ................. 5-16
- Display Configurations dialog box .............. 5-16
- Move Part command ................................... 5-17
- Remove command (Explode application) ......... 5-22
- Reposition command .................................. 5-22
- Explosion Properties dialog box ............... 5-24
- Activity: Explode ..................................... 5-25

**Animating an assembly** ............................... 6-1

- Animation Editor command .......................... 6-1
- Animation Editor Tool ............................... 6-2
- event duration bar .................................. 6-7
- Camera Path Wizard command ...................... 6-7
- Animation Properties dialog box .................. 6-7
- Duration Properties dialog box .................... 6-8
- Path command bar (Animation Editor Tool) .... 6-8
- Activity: Animating an assembly .................. 6-10

---

*Solid Edge Explode — Render — Animate application* 3
Activity: Rendering an assembly ......................... A-1
  Step 2 .................................................. A-2
  Step 3 .................................................. A-7
  Step 4 .................................................. A-26
  Activity summary ...................................... A-28

Activity: Creating a motor ................................. B-1
  Step 2 .................................................. B-3
  Step 3 .................................................. B-5
  Step 4 .................................................. B-6
  Step 5 .................................................. B-8
  Activity summary ...................................... B-10

Activity: Exploding an assembly ......................... C-1
  Step 2 .................................................. C-8
  Step 3 .................................................. C-10
  Step 4 .................................................. C-16
  Step 5 .................................................. C-18
  Step 6 .................................................. C-23
  Step 7 .................................................. C-29
  Step 8 .................................................. C-35
  Step 9 .................................................. C-40
  Step 10 .................................................. C-42
  Step 11 .................................................. C-42
  Activity summary ...................................... C-45

Activity: Animating an assembly ......................... D-1
  Step 2 .................................................. D-5
  Step 3 .................................................. D-12
  Step 4 .................................................. D-13
  Step 5 .................................................. D-15
  Step 6 .................................................. D-15
  Activity summary ...................................... D-19
Welcome to self paced training for Solid Edge. This course is designed to educate you in the use of Solid Edge. The course is self-paced and contains instruction followed by activities.

**Solid Edge self-paced courses**

- **spse01510**—Sketching
- **spse01515**—Constructing base features
- **spse01520**—Moving and rotating faces
- **spse01525**—Working with face relationships
- **spse01530**—Constructing treatment features
- **spse01535**—Constructing procedural features
- **spse01536**—Modeling synchronous and ordered features
- **spse01540**—Modeling assemblies
- **spse01541**—Explode-Render-Animate
- **spse01545**—Creating detailed drawings
- **spse01546**—Sheet metal design
- **spse01550**—Practicing your skills with projects
- **spse01560**—Modeling a Part Using Surfaces
- **spse01610**—Solid Edge frame design
- **spse01640**—Assembly patterning
- **spse01645**—Assembly systems libraries
- **spse01650**—Working with large assemblies
- **spse01655**—Revising assemblies
- **spse01660**—Assembly reports
- **spse01665**—Replacing parts in an assembly
Lesson 1  

*Introduction*

- **spse01670**—Designing in the context of an assembly
- **spse01675**—Assembly features
- **spse01680**—Inspecting assemblies
- **spse01685**—Alternate assemblies
- **spse01690**—Virtual components in assemblies
- **spse01695**—XpresRoute (tubing)
- **spse01696**—Creating a Wire Harness with Harness Design
- **spse01424**—Working with Solid Edge Embedded Client

**Start with the tutorials**

Self-paced training begins where tutorials end. Tutorials are the quickest way for you to become familiar with the basics of using Solid Edge. If you do not have any experience with Solid Edge, please start by working through the tutorials for basic part modeling and editing before starting this self-paced training.
Lesson

2 Course Overview

Course overview

The Explode-Render-Animate application within the Solid Edge assembly environment is a tool for creating different types of presentations of Solid Edge assemblies. Exploding an assembly allows you to control the movement, sequence and grouping of parts and subassemblies. Rendering a view allows you to define textures, lighting, shadows, backgrounds and other properties to create presentation style images. Motors apply movement to under constrained parts in an assembly which can be animated. Using Animation, you can combine previously created exploding sequences and custom camera movement to create animation. Each frame of the animation can be rendered to create presentation quality animations.

Once you complete the activities in this course, you will be able to:

• Assign material properties and textures to parts and subassemblies.

• Set viewing properties to change lighting, backgrounds, shadows, reflections, refractions and perspectives.

• Edit material properties to create different results in the final rendering.

• Control the sequence and direction of explode events.

• Add a motor to a unconstrained part of an assembly to create movement for an animation.

• Manipulate animation events and explode events to create an animation of an assembly.
Lesson

3 Rendering

Limited rendering is available in Solid Edge assembly using the settings in the View command. Advanced rendering in assembly is covered here and is contained in the Explode-Render-Animate environment.

Working with advanced rendering

The advanced rendering capabilities in Solid Edge are an extension of the Explode-Render-Animate application. This functionality can enhance the quality of images used in documents such as customer presentations or marketing and sales literature.

With the advanced rendering capability, you have a single view style called presentation view style that contains all of your rendering settings.
Lesson 3  

Rendering

A library of predefined entities such as materials, backgrounds, render modes, and light studios is available. You can customize the library with user-defined settings, but you cannot edit, delete, or modify the contents of the original library. This ensures protection for the original data stored in the library. Any custom settings you add to the library are stored in a separate file. You can have multiple libraries.

The advanced rendering capability uses the Solid Edge display for view manipulations. It supports part visibility and will only render what is on the screen. The Sharpen command is available when working with advanced rendering to allow you to make your graphics crisp and clear. Sharpening the display of the model will increase the quality of the rendering.

Supported advanced rendering entities

Advanced rendering provides rendering support for these entities:

- **Backgrounds**
- **Foregrounds**
- **Materials**
- **Environments**
- **Lighting Studios**
- **Render Mode**
- **Scenery**

Activating advanced rendering

Advanced rendering is activated automatically when you click the Render Scene and Render Area buttons when you have a Solid Edge Classic license. When you click these commands, two new tabs are added to PathFinder automatically.

- The Session Entities tab displays the name of the active assembly, along with a tree structure that shows you the entities that are applied to the assembly. You can right-click an entity to display a shortcut menu to:
  - Edit the properties of an entity as the basis for creating a new entity.
  - Detach (remove) a material that you have applied to the model.
  - Cut, copy, and paste an entity.
  - Rename an entity you created.

- The Predefined Archives tab displays a list of folders that contain predefined entities, such as backgrounds, foregrounds, and materials. You can right-click an entity to display a shortcut menu to:
  - Create a new archive folder or advanced rendering entity.
  - Apply an entity to the model.
  - Cut, copy, and paste an entity.
– Rename an entity you created.
– A toolbar on the Predefined Archives page contains commands used to create, save, open, close, and import customized entities in user-defined archive folders.

Any material, color, background, light, or scene that you want to customize needs to be applied to the assembly first, and then modified within the Session Entities tab to look the way you want it to. When you have adjusted the parameters of an entity so that it looks good on the model, you then copy the entity from the Session Entities page to a user-defined entity archive on the Predefined Archives page on PathFinder.

**Editing advanced rendering entities**

You can use the <Entity> Editor dialog box to edit the advanced rendering entity settings. To display the dialog box, click the Sessions Entity tab on PathFinder. Right-click the entity you want to edit. For example, if you want to change the material settings for the rendering, right click Materials. On the shortcut menu, click Edit Definition.

The options on the dialog box change based on the shader you select. A shader is designed to imitate a real-world look for things such as material, light, and rendering mode. Every component in advanced rendering is based on a shader, and each shader has multiple options that allow you to control the look and feel of the renderings.

**Applying advanced rendering entities**

There are two ways to apply an advanced rendering entity.

• You can select the entity from the library in the Predefined Archives tab and drag it onto the model in the graphics window.

• You can first select a model part in the graphics window, then right-click an entity in the Predefined Archives tab and choose Apply To Selected on its shortcut menu.

After applying the entity, you can use the Render Scene or Render Area command to see what the change looks like in the model.

**Saving an advanced rendered image**

You can use the Save As command to save a rendered image.

**Guidelines for saving advanced rendered images**

When saving images, you should follow these guidelines.

• To calculate the memory requirements for the image, multiply the image size (in pixels) * 4 (true color). For example, for an image 500 x 500 pixels, the memory requirements are 10 MB (500 x 500 x 4).

• To calculate the file size for the image, multiply the image size * 3 (true color).

• On the Image Options form, set the Alternate View Style to Presentation View Style.
Lesson 3  Rendering

Backgrounds

Backgrounds are a simple way of enhancing the screen area behind a model. They appear in reflective surfaces so they can impact a model’s appearance and add context to the model’s image.

Note

Backgrounds in advanced rendering inherit the background in Assembly.

Advanced rendering supports the following background shaders.

- Graduated
  
  A smooth linear transition from one color to another. In other words, there is a gradual change in background colors as you go from the top to the bottom.
• Image
• Plain
• None

To learn how to stretch a background image so that it fills the window, see the Help topic, Set a Background Image in Explode-Render-Animate.

**Foregrounds**

Foregrounds allow you to add additional view effects that help simulate various atmospheric effects such as fog. You can add foregrounds from the library or you can edit the view settings directly.

**Note**

Foregrounds in advanced rendering do not inherit any assembly settings.

Advanced rendering supports the following foreground shaders.
Lesson 3  Rendering

- Depth Cue
  Depth Cue fades an image to a particular color to portray a sense of depth in the image.

- Fog
- None

Materials
Advanced rendering includes a wide range of materials to simulate such things as wood, plastic, marble, and metal. It also supports advanced surface effects for texture maps and bump maps.
The material definition is inherited from the style definition in the assembly. For example, a part with a green style in the Assembly environment will initially be green material in advanced rendering. The materials applied to a model in advanced rendering are available only when using the Render Scene and Render Area commands in the Explode-Render-Animate application. For example, if you apply a red material to a green part, the part will still be green when you are not using these commands.

You can apply a material to a single or multiple occurrences of parts. For example, suppose you have several parts with a material definition of blue. If you change the material definition to dark blue, all parts with blue material are affected.

Advanced rendering supports several properties and allows you to set the following settings:

- Color
- Reflectance
- Transparency
- Displacement
- Texture space

When working in Explode-Render-Animate, you can modify the existing materials to create different colors and properties. Once that is done, you can create a new archive (.jwa file) for the modified entities, so you can apply them to different projects whenever you want.

**Color support**

You can define colors as plain colors, patterns such as wood, granite, and marble, or a textured map based on a bitmap image. The color settings support shaders such as plain, woods, marble, and wrapped images.
Lesson 3  
*Rendering*

**Reflectance support**

Reflectance properties affect the way light interacts with the materials. You can use these properties to apply such effects as:

- Mirror reflectance

![Mirror reflectance example](image1)

- Plastic reflectance

![Plastic reflectance example](image2)

- Glass reflectance

![Glass reflectance example](image3)

- Metal reflectance

![Metal reflectance example](image4)
The reflectance settings support shaders such as chrome 2D, conductor, glass, matte, metal, and mirror. Some of the most common options for these shaders include:

- **Specular factor**
  
  The specular factor is the amount of highlight or light reflected from a triangle where its normal matches the light vector.
  
  With a low specular factor, the appearance of the blue plastic seems to be dull,

  ![Specular factor example](image)

  compared to a high specular factor that produces a shiner, almost mirror-like effect.
– **Diffuse factor**

The diffuse factor is the amount of light reflected from triangles where the light is approximately 45 degrees from the light ray.

A low diffuse factor produces a dark image,

compared to a high diffuse factor.

– **Mirror factor**
Transparency support

Transparency is the amount of coverage by a color filter to simulate glass or some plastic materials. The values range from 0 for transparent to 1 for opaque. The transparency settings support shaders such as none, glow, plain, and wrapped image.

You can apply simple transparency to a model,

or combine it with properties such as reflectance, you can produce a more accurate looking image.

Displacement support

Surface displacement defines surface deformations by applying such effects as simple surface roughness, patterns such as leather and dimples, or tread plates. The displacement settings support such shaders as none, casting, leather, rough, wrapped displacements.
Wrapped displacement shaders simulate materials with an imprinted pattern. Some of the common wrapped displacement shaders include:

- **Wrapped tread plate**

  Wrapped tread plates imitates slip resistant shaped tread pattern. Also known as diamond plate, this material is commonly used for outdoor steps.

- **Wrapped knurl**

  Wrapped knurl imitates handgrips and is a common finish for barbell handgrips.

- **Wrapped dimple**

  Wrapped dimple simulates a slip resistant bubble-shaped pattern. Also known as diamond plate, this material is commonly used for outdoor steps.
• Wrapped leather

Wrapped leather imitates leather and is commonly used for camera bodies, chairs, and desk ground.

You can use the displacement settings to define a bump map based on bitmap images. The direction of the light source determines the surface texture of the rendering. Lighter areas are rendered as raised portions of the surface and darker areas are rendered as depressions in the surface. A gradient render is done between the light and dark areas.
You can use texture mapping to define how a texture is wrapped onto the surface.

**Light studios**

A light studio is the top-level container for all lights used in a model. It provides a fast and simple way to change the entire light scheme. You can change such things as:

- Shadows
- Intensity
- Shadow type
  Shadows can be soft or hard. Soft shadows are gradually diffused to create a more realistic lighting effect. Hard shadows can be colored and are useful for such effects as stained glass.
- Shadow resolution
Each light in the light studio has its own set of attributes, such as light type and color. These attributes are defined by a light shader.

You can quickly turn light sources on and off by setting or clearing the check box displayed adjacent to each light in the Light Studio branch of the Session Entity tree on the EdgeBar tool.

Lighting is very important to rendering because it gives a sense of depth to the scene and highlights the shiny surfaces. Lighting supports the following shaders:

- Ambient light
- Point light
- Spot light
- Distant light
- Sun
- Sky
- More

These shaders contain options that affect the light. Some of the most common options include color, intensity, and location.

Ambient light illuminates all surfaces regardless of orientation. This is useful for illuminating the scene that is not illuminated by other light sources.

Point light emits light equally in all directions from a point specified by an X, Y, and Z definition. This type of light is useful when lighting enclosed spaces or simulating the effect of a light bulb.
Spot light emits light from a single point and is contained by a cone. The starting and ending positions of a light are specified by X, Y, and Z definitions. This type of light is useful for focusing attention on the model or part of the model.

Distant light emits light parallel to a specific point as if it is from a very distant source. Solid Edge uses distant lights, which are used for general lighting.
To learn how to use the lighting controls, see the Help topic, Edit Light Entity Properties for Advanced Rendering.

**Render mode**

Advanced rendering provides rendering settings that allow you to control such things as reflections and the amount of light that bounces between objects. Advanced rendering does not inherit any rendering settings from the Assembly environment. Any changes you make to the rendering settings in advanced rendering do not change in Assembly.

Advanced rendering supports two classes of rendering:

- Photorealistic
- Artistic

Each render mode uses a shader to produce special effects and each shader includes a variety of options. The available options differ depending on the shader you select.

Photorealistic rendering supports ray tracing to show reflections and refractions. Photorealistic rendering supports such shader options as anti-aliasing, transparency, and reflections.

- Ray tracing—plots a path of imaginary rays from the observer’s eye through each pixel on the screen, back to the 3D environment. These rays are tracked as they bounce from one object to another to the light source.

- Anti-aliasing—a method of displaying elements on a low resolution device to make the object appear smoother. You can control the level of anti-aliasing. The more anti-aliasing you apply, the smoother the display will be, but it will also take longer to process.

You can choose from a variety of artistic rendering modes to make a 3D model look as if it was hand-drawn, painted, a mosaic, among others.
Scenery

Scenery allows you to enhance your renderings by adding such affects as tiled floors or water.

Advanced rendering supports the following types of scenes.

- Circular bases
- Panoramas
- Rooms
- Square bases
- None
Perspective command

Applies perspective to (A) or removes perspective from (B) the view for the active window.

You can quickly add or remove a perspective override using this command, but cannot change the perspective angle with this command.

Render Area command

Renders a fenced area.

Depending on the type of Solid Edge license you have, you may have advanced rendering capabilities available to you in the Explode-Render-Animate application in the Assembly environment. For example, if you have a Solid Edge Classic license, advanced rendering is available. If you have a Foundation license, advanced rendering is not available.

Render Scene command

Renders the active window.

Depending on the type of Solid Edge license you have, you may have advanced rendering capabilities available to you in the Explode-Render-Animate application in the Assembly environment. For example, if you have a Solid Edge Classic license, advanced rendering is available. If you have a Foundation license, advanced rendering is not available.
Activity: Rendering

Activity objectives

You will be working in the context of an assembly named *render.asm*. In this activity you will:

- Set parameters for changing backgrounds, foregrounds, light sources, and perspectives to control the display of a Solid Edge assembly.

- Enter the assembly application Explore-Render-Animate and assign materials and rendering properties to a Solid Edge Assembly.

- Edit parameters assigned from the predefined archive and better control the image display of rendered scene.

- Generate presentation quality images of a Solid Edge assembly using the rendering tools in the Explore-Render-Animate application.

Turn to appendix A for the Activity: Rendering an assembly.
Lesson

4 Defining motors

There are two types of motors that can be defined in Solid Edge: rotational and linear.

You use motor features to help you observe how a set of under-constrained parts will move relative to the part you define as a motor. This allows you to design and simulate complex mechanisms where the movement of a set of interrelated parts needs to be simulated.

Motor command

Defines a rotational or linear motor using an element on a selected part. You can then use the Simulate Motor command to display a kinematic simulation of the motion in an assembly.

You use motor features to help you observe how a set of under-constrained parts will move relative to the part you define as a motor. This allows you to design and simulate complex mechanisms where the movement of a set of interrelated parts needs to be simulated.

This is useful when working with assemblies that contain moving parts such as gears, pulleys, crankshafts, parts that travel in grooves or slots, and hydraulic or pneumatic actuators. For example, you can specify that a crankshaft part (A) in a mechanism rotates around an axis you specify (B).
You can then use the **Motor Simulation command** to playback a kinematic simulation of how the under-constrained parts in the assembly move.

Press F5 to replay the animation.
You can define properties for the motor, such as the type of motor, the motor rate or speed, motor direction, and any limits you may want to place on the motor.

When you define a motor feature using the Motor command, an entry is added for the motor feature to PathFinder. You can select the motor entry in PathFinder to edit the motor feature later.

**Types**

You can define the following types of motors:

- Rotation
- Linear

**Steps**

The basic steps for defining a motor are:

- Specify the type of motor you want, Rotation or Linear.
- Select the part you want to act as a motor.
- Define the movement axis.
- Specify the motor rate and limits.

**Specifying Motor Type**
Lesson 4  

Defining motors

The Motor Type list on the command bar allows you to define the type of motor you want. You can specify whether you want the motor type to be Rotation or Linear.

Selecting the Part
You can only select a part that is under-constrained, or has relationships suppressed. The assembly should also be under-constrained such that the mechanism is free to move in the proper axes.

Defining the Movement Axis
Depending on the motor type you specify, you can select faces, edges, or cylindrical axes to define the motor axis. For example, to define a Rotary motor, you can select cylindrical faces, cylindrical edges, or cylindrical axes.

Specifying the Motor Rate and Limits
The Motor Value and Limits options on the command bar allow you to specify the speed or rate you want the motor operate at, and any limits on the travel you want to impose. For example, you may want to specify that a rotational motor rotates at 1750 revolutions per minute, and makes two complete revolutions (720 degrees).

You can set the working units you want to use for the angular and linear velocity of a motor using the Advanced Units button on the Units tab of the File Properties dialog box, on the File menu.

Motor Definition and Simulation Guidelines
You can define as many motors as you want in an assembly. When you define multiple motors in an assembly, use the Motor Group Properties dialog box, available with the Simulate Motor command and the Animation Editor tool to specify which motors you want to use, whether you want to detect collisions during the simulation, and so forth.

When working with more than one motor, use the Animation Editor tool to specify when the motors start time, duration time and stop time for each motor. This allows you to design and simulate complex mechanisms where the timing and positioning of the parts is critical to understanding the behavior of the mechanism.

Note
Only motors in the active assembly participate in a motor simulation. If you want subassembly parts to move in response to a motor simulation, you need to make the subassembly adjustable, using the Adjustable Assembly command on the PathFinder shortcut menu.

Simulate Motor command
Display a kinematic simulation of motion in an assembly. You use motor features to define how a set of interrelated parts will move. This is useful when working with assemblies that contain crankshafts, gears, pulleys, and hydraulic or pneumatic actuators.

Press F5 to replay the animation.
When you click the Simulate Motor button, the Motor Group Properties dialog box is displayed, so you can specify which motors you want to use, whether you want to detect collisions during the simulation, and so forth. When you click OK, the Animation Editor tool is displayed so you can run the simulation. To run the simulation, click the Play button.

**Note**

The Simulate Motor command contains a subset of the Animation Editor functionality. To access the full functionality of the Animation Editor tool, you must use the Animation Editor command in the Explode-Render-Animate application. To access the Explode-Render-Animate application, on the Tools tab, click Explode-Render-Animate.

**Motor Group Properties dialog box**

- **No Analysis**
  Allows you to move under-constrained parts and observe the results.

- **Detect Collisions**
  Allows you to detect collisions during motor animation.

- **Physical Motion**
  Allows you to simulate physical motion between parts. This option detects contact between unconstrained surfaces and applies temporary constraints between the contacting surfaces. This makes it possible to analyze motion in mechanisms that contain gears and other forms of sliding contact.
Lesson 4  

Defining motors

Motor Duration
Specifies how the motor duration is defined.

Use Motor Limits as Duration if Defined
Specifies that the motor limits define the duration.

Default Motor Duration
Specifies the motor duration in seconds. You can type a value.

Available Motors
Lists the available motors. You can use the Add and Remove buttons to add motors to and remove motors from the Motors in Animation list.

Add
Adds a motor to the Motors in Animation list.

Remove
Removes a motor from the Motors in Animation list.

Motors in Animation
Lists the motors that will be used in the animation.

Activity: Motor

Activity objectives

In this activity, you will assign a motor to a part in an assembly. The type of motor will be a rotational type and be applied to a gear in a clock. The speed of the motor will be such that the second hand of the clock moves at the operating speed of 1 rpm. The gear relationships are predefined, and by assigning the motor to the appropriate gear, motion can be shown through motor simulation. The motor simulation used here will later be used to create an animation of the clock.

Turn to appendix B for the activity: Creating a motor.
Lesson

5 Exploding assemblies

Solid Edge enables you to easily create exploded views of your assemblies. You can use the exploded views you define in the Assembly environment to create exploded assembly drawings in the Draft environment. You can also create presentation-quality renderings and animations of exploded assemblies.

️ Automatic Explode command

Explodes the active assembly by applying a spread distance between parts.
The Automatic Explode command explodes assemblies based on the relationships applied between parts. In assemblies where the components are positioned using mate or axial align relationships, the Automatic Explode command quickly gives you excellent results.

**Note**

You cannot use this command to explode grounded parts or pipe components.

**Steps**

The basic steps for automatically exploding an assembly are:

- Specifying the components to explode.
- Defining the explode settings.

**Specifying the components**

You can use the Select option on the command bar to specify whether all the parts and subassemblies in the assembly are exploded or only the subassemblies you select are exploded. When you explode selected subassemblies, you can select the subassemblies in the graphics window or the Assembly PathFinder tab.

**Defining the explode settings**

You can use the options on the command bar and the Automatic Explode Options dialog box to specify how the components are exploded. For example, you can specify whether the spread distance between parts is calculated automatically, or you can specify the spread distance yourself.

When exploding an assembly that contains subassemblies, you can specify how the parts in the subassemblies are exploded using the Automatic Explode Options dialog box.
Calculating spread distance

The Automatic Spread Distance button on the command bar allows you to specify whether the spread distance between parts is calculated automatically by the Automatic Explode command, or that you want to specify the spread distance yourself.

- To have the spread distance calculated automatically, set the Automatic Spread Distance option.

- To specify the spread distance yourself, clear the Automatic Spread Distance option, then type the value you want in the Distance box.

When defining the spread distance yourself, you can type the value you want, then click the Explode button to see the result. To try another spread distance, type a new value, then click the Explode button again.

Binding subassemblies

When using the Automatic Explode command on an assembly that contains subassemblies, you can specify whether the parts in subassemblies are exploded (A) or the parts in subassemblies are grouped together as a single unit (B). To keep the parts in the subassemblies grouped together, set the Bind All Subassemblies option on the Automatic Explode Options dialog box.

If you want to explode the parts in some subassemblies (A), but not others (B), you can use the Bind Subassembly command to select the subassemblies you want to remain a single unit when exploded.
First, select the subassemblies in Assembly PathFinder, then click the Bind Subassembly command. A symbol is added adjacent to the subassembly entry in Assembly PathFinder to indicate that the subassembly is bound.

You can then clear the Bind All Subassemblies option on the Automatic Explode Options dialog box, and only the bound subassemblies you selected remain a single unit when you complete the command.

If you want to explode the subassembly later, you can use the Unbind Subassembly command to unbind the subassembly.

**Explode technique**

The Explode Technique option on the Automatic Explode Options dialog box allows you to specify whether the subassembly is considered or ignored when creating the explosion.

The By Subassembly Level option specifies that each subassembly is considered as a unique explosion. This keeps the parts in a subassembly adjacent to one another as they are exploded (A).

The By Individual Part option specifies that the subassembly structure is ignored when the parts are exploded. The parts are exploded based on their proximity to one another. This can result in parts in separate subassemblies being intermingled with one another. (B) This option duplicates the behavior used prior to version 19 of Solid Edge.
Explode PathFinder tab
The Explode PathFinder tab on PathFinder lists the explode operations in the order you perform them. You can use the Explode PathFinder tab to review and modify explode operations. When you save explode configurations, each explode configuration captures a separate set of explode operations. When you activate an explode configuration, the Explode PathFinder tab updates to list the operations captured for that configuration.

Grounded parts
The Automatic Explode command cannot explode parts that are grounded. For example, when you create a new part within the context of the assembly using the Create In-Place option, the part is positioned using a ground relationship. You can use the Explode command to manually explode a grounded part, or you can delete the ground relationship, then position the part using assembly relationships, such as mate and align.

Automatic Explode command bar
Automatic Explode Options dialog box

Edit Flow Lines command
Edits a flow line between two exploded parts. You can make the following types of changes to a flow line:
- You can change the length of a flow line by editing the end point position of either end of the flow line.
- You can change the location of a joggle segment on a flow line.
Lesson 5  Exploding assemblies

- You change the location of the entire flow line.

**Changing Flow Line Length**

You change the length of the flow line by selecting it at the end you want to edit (A), then drag the cursor to the new position you want (B).

**Changing Joggle Segment Position**

If the Move Exploded Part command is used to move the part outside of the original explode vector, a joggle is added to the flow line. You can use the Edit Flow Lines command to drag the joggle segment (A) to a new position (B).
Changing Flow Line Location

The location and length of a flow line is determined automatically by using the range box of the parent and child parts. The flow line terminator end originates at the center of the range box on the parent part. (A) The range box is the theoretical 3D envelope that the solid body is contained within. For some parts, you may want to change the flow line location.

To relocate an entire flow line, click near one end of the flow line (A), then click an edge or face that you want to connect that end of the flow line to (B).
The flow line position is updated (A). You may also want to change the flow line length so you can better view the flow line terminator (B) in the current view orientation.

**Other Flow Line Operations**

You can also perform the following actions on flow lines:

- To display or hide flow line terminators, set or clear the Flow Line Terminators command on the View menu.

- To display or hide all flow lines, set or clear the Flow Lines command on the View menu.

- To display or hide an individual flow line, select the part in the graphic window or PathFinder, then click the Show Flow Lines or Hide Flow Lines commands on the shortcut menu.

- To delete a joggle segment on a flow line, select the proper event in the Explode PathFinder tab, then click the Delete command on the shortcut menu. This has
the same effect as using the Move Exploded Part command to move the part back within an earlier explode vector.

- When you collapse a part with the Collapse command, the flow line is deleted.

The Show Flow Lines and Hide Flow Lines commands are also available on the shortcut menu when you select an explode event in the Explode PathFinder tab.

**Note**

You can only select flow lines in the graphics window with the Edit Flow Lines command, or in the Explode PathFinder tab with the Select Tool.

### Flow Lines command

Displays or hides all the flow lines between exploded parts.

### Bind Subassembly command

Groups the parts in a subassembly so they will explode as a single unit when using the Automatic Explode or Explode commands. To bind a subassembly, you must first select it using PathFinder.

A symbol is added adjacent to the subassembly entry in PathFinder to indicate that the subassembly is bound. You can use the Unbind Subassembly command to unbind a subassembly.
Unbind Subassembly command

Ungroups a subassembly that was grouped using the Bind Subassembly command.

Explode command

Explodes one or more parts in a specified direction. The parts (A) selected for explosion are offset along an explode vector you define by selecting a face or reference plane on a base or reference part (B).
You can manually explode a single part, multiple parts, and bound subassemblies. You define the offset distance using the Distance box on the command bar.

**Note**

Parts that were exploded with the Automatic Explode command can be re-exploded along a different explode vector using this command.

**Steps**

The basic steps for manually exploding parts are:

- Select the parts to explode.
- Select the base part.
- Select a face or reference plane on the base part.
- Specify the explode direction.

**Exploding Multiple Parts**

When you select multiple parts to explode in one operation, you can use the Manual Explode Options dialog box to specify whether the parts are spread out evenly, or that the parts are moved as a single unit.

**Spreading Components Evenly**

When you set the Spread Components Evenly option, you can use the Manual Explode Options dialog box to define the explode order you want. You can select one or more parts in the Explode Order list, then use the Move Up and Move Down buttons on the dialog box to define the explode order you want. When you select a part in the list, it highlights in the graphic window. This allows you to reorder the parts as you explode them.
Moving as a Single Unit

When you set the Move Components as a Single Unit option, the current relative position of the set of parts is maintained, and they are relocated along the explode vector you defined.

Exploding Bound Subassemblies

When you select a bound subassembly to explode, it is exploded as a single unit. In other words, the components within the subassembly are not spread out.

Collapse command

Returns an exploded part to its original assembly position relative to its parent part.

You can collapse several parts in one operation by holding the Shift key and selecting the parts you want to collapse. If you select a part that is a component in a bound subassembly, the entire subassembly is collapsed.

When you collapse a part, the flow line for the part is deleted.

Explode PathFinder tab

Provides alternate ways of viewing and editing an exploded assembly. The Explode PathFinder tab displays the structure for the current exploded view configuration in a hierarchical list. The Explode PathFinder tab helps you work with the components that make up an exploded view.
This allows you to view the structure and perform edit operations on the current exploded view configuration. Some of the operations you can perform include:

- You can select an explode event, then edit the offset or rotational value using the command bar.

- You can use the commands on the shortcut menu to show and hide parts, collapse parts, show and hide flow lines, and so forth.

- You can add and remove parts from explode Groups and Event Groups. This is useful when working with animations.

The following table explains the symbols used in Explode PathFinder:

<table>
<thead>
<tr>
<th>Legend</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Part" /></td>
<td>Part</td>
</tr>
<tr>
<td><img src="image" alt="Assembly" /></td>
<td>Assembly</td>
</tr>
<tr>
<td><img src="image" alt="Group" /></td>
<td>Group</td>
</tr>
<tr>
<td><img src="image" alt="Event Group" /></td>
<td>Event Group</td>
</tr>
<tr>
<td><img src="image" alt="Linear Event" /></td>
<td>Linear Event</td>
</tr>
<tr>
<td><img src="image" alt="Rotational Event" /></td>
<td>Rotational Event</td>
</tr>
<tr>
<td><img src="image" alt="Moved Parts" /></td>
<td>Moved Parts</td>
</tr>
<tr>
<td><img src="image" alt="Unexploded Parts" /></td>
<td>Unexploded Parts</td>
</tr>
</tbody>
</table>

**Explode groups and event groups**

The way the parts and subassemblies are arranged in the Explode PathFinder tab is based on the operations you performed to create the exploded view. These operations, or events, are collected into one or more explode operation collections in Explode PathFinder.
There are two types of explode operation collections: Groups and Event Groups. The groups and event groups are created automatically as part of the explosion creation process, but you can edit them later.

**Groups**

A Group collects all the parts and subassemblies that participate in a common explode vector. It is possible for a group collector to have additional groups nested within it. For example, if one part in the explode vector has parts branching off into a different explode vector, the branched parts will be in a group nested within the main group. The components within a group animate sequentially.

**Event Groups**

An Event Group collects all the components that will move simultaneously in an animation. For example, a pattern of fasteners would typically be in an Event Group. You can add parts to and remove parts from an event group.

**Explode PathFinder and the graphics window**

Similar to the PathFinder tab in an assembly, when you select an entry in Explode PathFinder, the associated parts highlight in the graphics window. For example, if you select a Group entry in Explode PathFinder, the parts associated with that entry highlight in the graphic window.

If you select a part in the graphics window, a box is displayed in Explode PathFinder to indicate where in the exploded view tree structure the selected part is located.
Exploding assemblies

Explode configurations and explode events

When you save an exploded view configuration, each explode configuration captures a separate set of explode events. When you activate an exploded view configuration, the Explode PathFinder tab updates to list the events captured for the current configuration.

Adding and removing parts from event groups

You can add and remove parts from an Event Group to control which parts move simultaneously during an assembly animation. The Add To Event Group and Remove From Event Group shortcut menu commands in the Explode PathFinder tab allow you to make these types of changes. For example, you may want all the fasteners in an assembly to animate at one time, even though the results of the Automatic Explode command placed them in different explode event groups.

Note

The Add To Event Group and Remove From Event Group commands are not available when the Animation Editor is displayed.

For more information on assembly animations, see the Creating Assembly Animations Help topic.

Reordering groups

You can change the order of an explode Group, but not an Event Group using the Explode PathFinder tab. This allows you to change the sequential order in which the parts move in an assembly animation.
Lesson 5  

Exploding assemblies

Use the Select Tool to drag and drop an explode Group to a different location. 
Explode PathFinder displays a symbol to show where you can reposition the Group in the explode structure. The symbol changes if you drag the Group to an invalid location in the explode structure.

Display Configurations command

Saves, applies, or deletes a display configuration of an assembly. A display configuration captures the display status of the parts, assemblies, assembly sketches, weld beads, and reference planes in an assembly.

Using display configurations can be useful when working with large assemblies.

To apply a saved configuration, you can also use the Configuration drop list on the Home tab—>Configurations group.

You can apply display configurations that were defined in the current assembly, or display configurations that were defined in a subassembly. To apply a display configuration defined in a subassembly, you must select the subassembly first.

For more information, see the Using display configurations and Working with large assemblies efficiently Help topics.

Display Configurations dialog box

Saves, applies, or deletes a display configuration in the active assembly.

Dialog Box Options
Configuration Name
Displays the configuration name. You can type a new name or select an existing name from the list. You should avoid using special characters in configuration names. For example, special characters such as \ / : are not allowed.

Apply Activation Override
Allows you to specify how you want to apply the display configuration. When this option is set, you can specify whether the parts in the assembly are activated or inactivated when you apply the display configuration. When this option is cleared, the active or inactive status of the parts is determined by their status when the configuration was saved.

Activate All Parts
Specifies that all parts in the assembly become active when you apply the configuration.

Inactivate All Parts
Specifies that all parts in the assembly become inactive when you apply the configuration.

Maintain Current State
Specifies that the current activation state (inactive or active) of the parts in the assembly is not changed when you apply a display configuration. Setting this option improves performance when working with large assemblies.
When you apply a display configuration from the Select Tool command bar, the current dialog box setting is honored. If you want to change the current activation or override setting when applying a display configuration, you must apply the configuration using the Display Configurations dialog box.

Apply Simplify Override
Allows you to specify how you want to apply the display configuration. When this option is set, you can specify whether the parts in the assembly are simplified or designed when you apply the display configuration. When this option is cleared, the simplified or designed status of the parts is determined by their status when the configuration was saved.

Use All Simplified Parts (When Available)
Specifies that the simplified version of parts is used when you apply the configuration.

Use All Design Parts
Specifies that the designed version of parts is used when you apply the configuration.

Maintain Current State
Specifies that the current simplified state (simplified or as designed) of the parts in the assembly is not changed when you apply a display configuration. Setting this option improves performance when working with large assemblies.

When you apply a display configuration from the Select Tool command bar, the current dialog box setting is honored. If you want to change the current activation or override setting when applying a display configuration, you must apply the configuration using the Display Configurations dialog box.

Configuration File
Displays the name of the current configuration file, which contains configuration names and display information. You can type a name or use the Browse button to find another configuration file.

Browse
Accesses a dialog box that allows you to search for a document.

Apply
Applies the configuration name you selected to all assembly windows.

Save
Saves the configuration name to the current configuration file.

Delete
Deletes the configuration name.

Move Part command
Moves or rotates parts in an exploded view in an assembly. You can use this command to do the following:
Lesson 5  
*Exploding assemblies*

- Move one or more parts along the original explode vector or a new vector you define.

- Rotate one or more parts along the original explode vector or a new vector you define.

- Move one or more parts within a plane you define.

You can move or rotate a single part, a set of parts, or a part and all its dependent parts. The same basic steps apply whether you are moving, rotating, or moving within a plane.

**Moving parts along the original explode vector**

- To move a single part: select the part, then drag it to the new location.

- To move a set of parts: select the parts, then click the Accept (check mark) button on the command bar.
When you click the Accept button, an orientation triad is displayed, with the X-axis oriented to the explode vector. By default, the original explode vector axis is selected. Drag the cursor to move the set of parts to the new location.

- To move a part and all its dependent parts: set the Move Dependent Parts option on the command bar, then select the part you want to move. The part and all its dependent parts highlight. When you click the Accept button, an orientation triad is displayed. By default, the original explode vector axis is selected. Drag the cursor to move the set of parts to the new location.
Lesson 5  Exploding assemblies

Moving parts along a different explode vector

To move one or more parts along a different explode vector, first define the select set of parts. For example, you can use the command bar to specify that you want to move a part and all its dependent parts. After you click the Accept button, position the cursor over the triad axis you want to move along, then drag the cursor. A joggle is added to the flow line automatically. When you offset the part in a new direction, a new explode event is added to the Explore PathFinder tab.

When parts have been moved outside of their original explode vector, you can also move them back into their original explode vector. Select the parts you want to move, select the proper axis, then drag the parts back to the original explode vector. When you get close to the original explode vector, the parts will automatically lock into the original vector. The joggle segment will be automatically removed.

Rotating parts

To rotate one or more parts, first set the Rotate option on the command bar. Define the select set of parts, then position the cursor over the axis you want to rotate about, and then drag the cursor to the new location.
Moving parts within a plane

To move one or more parts within a plane, first set the Move Planar option on the command bar. Define the parts you want to move (A), then define the plane you want to move the parts within. The movement plane is defined by the X axis (B) and another axis you select. For example, you can move a part within the plane defined by the X axis and Z axis (C). Then drag the cursor to the new location (D).

With the Move Planar option, parts are typically moved outside of the original explode vector axis. If so, a joggle is added to the flow line.
Lesson 5  Exploding assemblies

For additional information on working with exploded views, see the Creating Exploded Views of Assemblies and Explode PathFinder tab Help topics.

Remove command (Explode application)

Hides the selected part in the exploded view and returns the part to its unexploded assembly position.

You can remove several parts in one operation by holding the Shift key and selecting the parts you want to remove. If you select a part that is a component in a bound subassembly, the entire subassembly is removed.

You can use the PathFinder tab to re-display the parts later.

Reposition command

Repositions a part with respect to another reference part in an exploded view. This can be useful when you want to change the position of a part after using the Automatic Explode command.

To reposition a part, select the part you want to reposition (A), then position the cursor over the reference part (B). The reference part highlights, and an arrow

spse01541
is displayed on the reference part to indicate which side of the reference part the selected part will be repositioned to.

If the arrow does not point in the direction you want, highlight a different reference part. If the reference part is the last part in an explode vector sequence, a dynamic arrow is displayed to indicate that you can choose the side of reference part where you want to reposition the selected part.

If the part you select is within a bound subassembly (A), all the parts in the subassembly will be repositioned (B).
Lesson 5  *Exploding assemblies*

You use this command to change the order in which the parts are exploded. To relocate a part without changing its order, you can use the Move Exploded Part command.

**Explosion Properties dialog box**

- **Configuration**
  - Specifies which explode configuration you want to use.
    - Use Explode From Configuration
      - Lists the existing exploded view configurations you can use in an animation. You can specify one exploded view configuration for an animation.

- **Speed**
  - Specifies the speed you want to use.
    - Common Velocity for All Parts
      - Specifies that the same velocity is used for all parts. You can type a value.
    - Explosion Duration
      - Specifies that you want to type a value in seconds for each explode event.

- **Animation Order**
  - Specifies how you want the animation to start.
    - Innermost First
      - Specifies that you want to start the animation by moving the innermost parts first.
    - Outermost First
      - Specifies that you want to start the animation by moving the outermost parts first.

- **Initial State**
  - Specifies whether you want to start the animation with the parts collapsed or expanded.
    - Collapsed
      - Specifies that the animation starts with the parts collapsed.
    - Expanded
      - Specifies that the animation starts with the parts expanded.
Activity: Explode

Activity objectives

In this activity, you will use the Explode-Render-Animate application to explode an assembly. In this activity, you will accomplish the following:

- Use the Manual Explode command to order and sequence the events of an explosion.

- Define the distances and directions of exploding parts along a time line.

- Group parts and subassemblies and control how they behave during and explosion and when they explode.

- Creating an animation time line to be used in an animation sequence.

- Use the Automatic Explode command to begin an exploding sequence.

Turn to appendix C for the activity: Exploding an assembly.
Solid Edge enables you to easily create animated presentations of your assemblies. Assembly animations can be useful for motion studies of mechanisms, visualizing how parts are assembled into a completed assembly, and vendor or customer presentations.

Animation Editor command

Displays the Animation Editor Tool so you can create, display, and edit animations of an assembly.
You can define the following types of animation events:

- Camera
- Motor
- Explosion
- Appearance
- Motion Path

You can use the controls on the Animation Editor tool to play, stop, pause, and rewind the animation in the graphic window.

You can also save an assembly animation in AVI format with the Save As Movie button on the Animation Editor tool.

**Note**

When you are working in Solid Edge Embedded Client, AVI files are saved to unmanaged locations.

For more detailed information on creating assembly animations, see the Creating Assembly Animations Help topic.

**Animation Editor Tool**

Animation List
Lists the existing animations. You can select an animation entry from the list for playback and editing purposes.
New Animation
Displays the Animation Properties dialog box so you can define the properties for a new animation.

Save Animation
Saves the current animation.

Delete Animation
Deletes the current animation.

Animation Properties
Displays the Animation Properties dialog box so you can edit the properties for an existing animation.

Save as Movie
Displays the Save as Movie dialog box so you can save the current animation as an AVI file.

Camera Path
Displays the Camera Path Wizard so you define the camera path you want.

Display Camera Path
Displays the camera path as a curve in the graphic window. This can be useful in visualizing the path the camera will take during the animation.

Animation Events List (Left Pane)
Lists the event types available in the current animation. Depending on the current animation, you can define events or select existing events for the camera, motor, explosion, appearance, and path you want to use for the current animation. You can expand, collapse, and select items in the list. Shortcut menu commands are available that allow you to define the event you want to use for the animation, delete the current event, and so forth.

Speed
Specifies the speed you want to use for playback purposes. The speed setting does not affect the speed of an AVI recording, or the relative speed of the animation entries.

Go to Start
Moves the current frame indicator to the start of the animation.

Previous Frame
Moves the indicator to the previous frame.

Play/Pause
Plays or pauses the current animation.

Stop
Stops the playback of the animation.
Lesson 6  Animating an assembly

Next Frame
Moves the indicator to the next frame.

Go To End
Moves the current frame indicator to the end of the animation.

Time
Displays the current time in the animation.

Frame
Displays the current frame in the animation.

Toggle Scale
Toggles the timeline scale between frames and seconds.

Zoom Out
Reduces the scale of the animation timeline.

Zoom In
Increases the scale of the animation timeline.

Minimize
Minimizes the Animation Editor.

Motion Path
Displays the Motion Path command bar so you can select components and draw a curve path to guide component movement.

Appearance
Displays the Appearance command bar so you can create an appearance event. For example, you may want a part to fade in or fade out in your animation.

Event Timeline and Duration List (Right Pane)
Displays event duration bars, which represent the start and stop times, and elapsed time for each event in the current animation timeline. You can edit event duration bars by dragging with the cursor or using shortcut menu commands. This allows you to customize the animation.
Basic user-interface elements in the right pane include:

(A) Frame Scale. You can use the Toggle Scale button to change the scale display between Frames and Seconds.

(B) Current Frame Indicator. The current frame is the frame which is displayed in the graphic window. You can use the cursor to drag the Current Frame Indicator to another location to view individual frames in the animation.

(C) Event Duration Bars. Notice that a different color is used at the start and end locations.

(D) Selected Event Duration Bar. Notice that a scale is displayed when a duration bar is selected. This can make it easier to precisely relocate a duration bar with respect to Frame Scale.

(E) Event Duration Bar Key Frame Indicator.

(F) Vertical Scroll Bar. Allows you to scroll the timeline up and down.

(G) Horizontal Scroll Bar. Allows you to scroll the timeline left and right.

**Shortcut Menu Commands**

The following shortcut menu commands are available. The shortcut menu commands are context-sensitive. In other words, the commands which are available change based on what is selected.

**Left Pane Shortcut Menu Commands**

- Delete
  - Deletes the selected event.
- Rename
  - Renames the selected event.
Lesson 6  Animating an assembly

Edit Definition
Allows you to define a new event or edit an existing event. The action you can perform depends on the event type and whether you are defining a new event or editing an existing event.

Camera
The Edit Definition command displays the Camera Path Wizard when you click the Camera category entry, and displays the Path command bar when you select an existing camera event.

Motor
The Edit Definition command displays the Motor Group Properties dialog box when you select the Motor category entry.

Explosion
The Edit Definition command displays the Explosion Properties dialog box when you select the Explosion category entry.

Appearance
The Edit Definition command displays the Appearance command bar when you select an existing Appearance event.

Paths
The Edit Definition command displays the Path command bar when you select an existing Path event.

Expand All
Expands all the event collections.

Right Pane Shortcut Menu Commands
Cut
Cuts the selected event from the animation and places it on the Clipboard.

Copy
Copies the selected event from the animation and places it on the Clipboard.

Paste
Pastes an event onto the animation timeline.

Delete Duration
Deletes the selected event duration.

Insert Key Frame
Inserts a keyframe at the current cursor position. This option is available when the cursor is over a camera or motion path event duration bar.

Delete Key Frame
Deletes a keyframe at the current cursor position. This option is available when the cursor is over a camera or motion path event duration bar.

Insert Camera Location
Inserts a camera location at the current cursor position. This option is available when the cursor is over a camera event duration bar.
Animating an assembly

Add Frames
Displays the Add Frames dialog box so you can add frames or time to an animation event.

Remove Frames
Displays the Remove Frames dialog box so you can remove frames or time to an animation event.

Properties
Displays the Duration Properties dialog box so you can redefine the start time, end time, or elapsed time for an animation event.

event duration bar
A user-interface element on the timeline (right) pane of the Animation Editor tool. Event duration bars allow you to visualize and control the timing of events in an assembly animation.

Event duration bars represent the start time, elapsed time, and end time for an animation event. There are two basic types of event duration bars:

- Duration bars for explode, appearance, and motor events.

- Duration bars for camera and motion path events. Duration bars for these event types also support key frames (A).

You can move and modify duration bars using the cursor and shortcut menu commands.

Camera Path Wizard command
Runs the Camera Path Wizard, which guides you through the process of creating a camera path for an assembly animation. The Camera Path Wizard allows you define the camera path name, camera direction, and so forth. You can use camera paths as part of an assembly animation.

Animation Properties dialog box

Animation Name
Displays the name of the animation.

Frames Per Second
Specifies how many frames per second are used to build your animation. You can specify a standard frame rate, such as NTSC or PAL, or a custom frame rate.
Lesson 6  

*Animating an assembly*

NTSC
Specifies that the NTSC standard frame rate is used to build the animation.

PAL
Specifies that the PAL standard frame rate is used to build the animation.

Custom
Allows you to define a custom frame rate. Type the number of frames per second you want.

Animation Length
Specifies the duration of the animation in seconds.

**Duration Properties dialog box**

Start Frame
Lists the current start frame. You can type a new value to change the starting time for the event duration.

End Frame
Lists the current end frame. You can type a new value to change the ending time for the event duration.

Entry Duration
Lists the current duration of the event entry. When you change this value, the End Frame value also updates.

**Path command bar (Animation Editor Tool)**

This command bar is displayed when you are creating or editing Motion Path or Camera Path events.

Select Parts Step
Specifies the parts you want to follow the motion path. Select the parts you want in the graphic window. This step is only available when creating or editing a motion path.

Draw Path Step
Draws a path to guide component or camera motion. You can draw a curve that defines the path in the graphic window.

Finish/Cancel
This button changes function as you move through the motion path definition process. The Finish button applies the motion path properties you defined. The Cancel button discards any input and exits the command.

Select Parts Step Options
- Deselect (x)
  Clears the selection.
- Accept (check mark)
  Accepts the selection.
Draw Path Step Options
Activate Part
Activates the selected part.

Keypoints
Sets the type of keypoint you can select to define the motion path curve. The available keypoint options may be different than displayed below.

- ![Keypoint](image) Allows you to select any keypoint.
- ![Keypoint](image) Allows you to select an end point.
- ![Keypoint](image) Allows you to select a midpoint.
- ![Keypoint](image) Allows you to select the center point of a circle or arc.
- ![Keypoint](image) Allows you to select a tangency point on an analytic curved face such as a cylinder, sphere, torus, or cone.
- ![Keypoint](image) Allows you to select a silhouette point.
- ![Keypoint](image) Allows you to select an edit point on a curve.

Open Path
Sets the path curve type to open.

Closed
Sets the path curve type to closed. The start and end points of a closed path curve are coincident. If the start and end points you selected are not coincident, and you set the Closed option, a keypoint that is coincident with the start point is automatically added to the curve.

When you set this option, the Start and End options are automatically set to Periodic. Periodic curves are closed, connected, and tangent at the first and last points on the curve.

Frame Count
Specifies the total frame count for the path.

Straight Path
Creates the path with straight segments.

Blend Path
Creates the path with curved or blended segments.

Hold
Holds the component position until the next key frame.

Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.
Activity: Animating an assembly

Activity objectives

In this activity, you will use the animation portion of the Explode-Render-Animate application to produce a presentation quality animation. The animation will be created and then different effects will be used to edit the animation and give the desired results. The animation time line you create will consist of a motor driving under-constrained parts, explosion events, camera events, and appearance events. The end result will be an .avi movie.

Turn to appendix D for the activity: Animating an assembly.
A Activity: Rendering an assembly

Step 1
In the following steps, you will be working in the context of an assembly document render.asm. Before entering the Explode-Render-Animate application, you will assign properties to some parts and change some viewing parameters within the Solid Edge Assembly environment. These settings will carry over into the Explode-Render-Animate application and will be available there unless they are overridden by another parameter in that application.

You will make the glass face clear by setting the face style.

• Open the assembly render.asm and activate all the parts in the assembly.
Activity: Rendering an assembly

- In PathFinder, right-click `housing.asm`, and then click Edit.
- In PathFinder, right-click `glass.par`, and then click Edit.
- On the ribbon, choose View tab→Style group→Part Painter.

- On the Part Painter command bar, set the Style to White (glass) and the Select method to Any.

- In the graphics window, select the revolved protrusion to set the face style.
- On the command bar, click the Close button.
- On the ribbon, click the Close and Return button to return to `housing.asm`.
- On the ribbon, click the Close and Return button to return to `render.asm`.

Step 2

The numbers for the clock face have been created and stored in a TIFF format image. You will now assign this image to the clock face as a texture. To do this, you will create a new face style based on the properties of an existing face style. You will then modify the face style by assigning the TIFF image as a texture and then orienting it appropriately.

- In PathFinder, right-click `SE_face.par`, and then click Edit.
- On the ribbon, choose View tab→Show group→Hide Previous Level to turn off the display of the assembly (if it is visible).

- Choose View tab→Style group→View.

- Set the Render mode to Smooth with VHL Overlay.
- Turn on Textures, then click OK.
- Choose View tab→Style group→Styles.
Activity: Rendering an assembly

- Set the Style type to Faces Styles.
- Set the Style to White (glass).
- Click New.
- In the Name field, type Clockface, but do not press Enter.

**Note**

By pressing Enter, the new style Clockface will be created and you will return to the Faces Style menu. To make further changes to the style Clockface, you will need to select Clockface, then click Modify.

- Click the Texture tab.
- Browse for the texture file *clockface.tif*, and click Open.
- Click OK to close the New Faces Style dialog box, and then click Close to dismiss the Style dialog box.
- On the ribbon, choose View tab→Style group→Part Painter.
Activity: Rendering an assembly

- Set the Style to Clockface and the Select method to Face.

  ![Style Selection](image)

- Select the front face of the clock, and then click the Close button on the command bar.

  ![Clockface Image](image)

**Note**

You will edit the style Clockface to correct the problems with the texture.

- Choose View tab→Style group→Styles.

  ![View Tab](image)

- Select Faces Style.

- Select Clockface, and then click Modify.

- Click the Texture tab, and modify the Rotation angle to 270, such that the orientation of the clock face is correct.
Activity: Rendering an assembly

- Click the Appearance tab. Set the values as shown. Click OK, and then click Apply.
  - Shininess: 0.25
  - Reflectivity: 0.20
  - Opacity: 1.0

Note
Create the face style in the template and it will be available for future geometry created with that template.
Activity: Rendering an assembly

- Choose View tab→Show group→Hide Previous Level to display the assembly again.
Step 3

You will now enter the Explode-Render-Animate application and create presentation quality images.

- Choose Tools tab→Environ group→ERA.
Activity: Rendering an assembly

- Choose Home tab→Render group→Render Setup.

- In the Render Setup dialog box, turn on all the Automatic Render Options and Use Progressive Rendering, and then click OK.

- In PathFinder, click the Session Entities tab.

  **Note**
  
  The Session Entities tab in PathFinder contains rendering settings and parameters that have been defined up to this point in time. These parameters can be edited and the values modified. You will be adding new values from the Predefined Archives. Values in Predefined Archives cannot be changed, but once used, the entry in the Session Entities page can be renamed and modified.

- In PathFinder, click the Predefined Archives tab.

  **Note**
  
  To use a setting in the Predefined Archives, you will drag the setting into the rendered scene. To set geometry-specific settings, such as material textures, you will drag the material onto the desired part. For view-specific settings, such as backgrounds and lighting, you will drag the setting anywhere into the rendered scene.

- Drag Backgrounds→Graduated→Green into the rendered scene.

  **Note**
  
  Because you set the rendering options to automatically render upon a background change, the scene is automatically rendered. If this parameter was turned off, you would need to manually render the scene by clicking the Scene command.

- You will now modify the parameter you just set. In PathFinder, click the Session Entities tab.
Activity: Rendering an assembly

- In PathFinder, right-click Background, and then click Edit Definition.
- Set the Bottom Color to be the color shown, and click OK. Click OK to exit the Background Editor.

![Color Palette]

- In PathFinder, click the Predefined Archives tab.

![Archives Tab]

- Drag Render Modes→Photorealistic→Photorealistic, high quality into the rendered scene.
Activity: Rendering an assembly

- Drag Light Studios→High-Contrast→Left spot with back into the rendered scene.
You will now modify the parameter you just set. In PathFinder, click the Session Entities tab.

To see the effect of the left spot on the rendered scene, turn off the Left Spot and then click the Home tab→Render group→Scene command.
Activity: Rendering an assembly

- Turn Left Spot on again, and then click the Scene command.
- You will now modify the Left Spot definition. Right-click Left Spot, and then click Edit Definition.
- In the Light Editor dialog box, set the cone angle to 40°.
- Click the Placement tab. Click the Front View button, and drag the handles so that the front looks approximately like the view below.
Now select the Top View button and drag the handles of the cone to the approximate position shown.
Activity: Rendering an assembly

- Select the Right View button and drag the handles of the cone to the approximate position shown. Check the top, front and right views. Changes made in one view could move the viewing cone in another. It may take you several iterations to achieve the desired results.
• Click OK to exit the Light Editor dialog box, and return to the rendered scene.

• You will add a new light source. In PathFinder, right-click Lighting Studio and click Add.

• Right-click New Spot Light, and then click Edit Definition.
- On the Placement tab, set the viewing cone as shown for the top, front and right buttons.
Activity: Rendering an assembly

- Click OK to exit the Light Editor dialog box and return to the rendered scene.
Activity: Rendering an assembly

- In PathFinder, click the Predefined Archives tab.

- Drag Scenery→Square Bases→Treadplate into the rendered scene.

- You will now modify the parameter you just set. In PathFinder, click the Session Entities tab.

- Right-click Scene→Base→Treadplate, and then click Edit Definition.

- Select the 2D Texture Space tab and set the S scale value to 0.30 and the T scale value to 0.30. Click OK to exit the Material Editor.
• In PathFinder, right-click Scene, and then click Edit Definition. On the Configuration tab, change the X axis and Y axis to 30, and then click OK.

• In PathFinder, click the Predefined Archives tab.
Activity: Rendering an assembly

- Drag Materials→Wood→Mahogany→Polished mahogany onto the part case.par.
Activity: Rendering an assembly

- Drag Polished mahogany onto the part `backplate.par`.

- Now we will assign a different wood to the same two parts. Drag Materials→Wood→Japanese Oak→Polished Japanese oak onto the part `case.par`.
Activity: Rendering an assembly

- Drag Polished Japanese oak onto the part backplate.par.
- Drag Materials→Glass→Clear (glass) onto the part glass.par.
Activity: Rendering an assembly

- You will now modify the parameters you just set. In PathFinder, click the Session Entities tab.

Note

Even though you changed the material from polished mahogany to polished Japanese oak, and there is no longer any polished mahogany in the rendered scene, entries for polished mahogany exist in the Sessions Entities page.

Each time you drag a material onto a part, a unique material is created in the Sessions Entity page. The new material name is an incremental number and is exactly as the one that was chosen. Future modifications to properties do not affect other occurrences previously placed. To make a modification to a property and have it uniformly appear on all parts of that property, the modification should come first, then be applied to the parts.

A good practice is to rename the material to something that indicates its use. For example, Polished Japanese Oak can be called Polished_J_Oak_Front_Housing.

Materials that appear in the Sessions Entities page of PathFinder, that are no longer used in the scene are removed from the Session Entities upon leaving the Explode-Render-Animate application. For example, if you change the glass face of the clock from Clear (glass) to Brown (glass), you will see Clear (glass) material in the Session Entities page until you leave the application. The materials in the Sessions Entities page are recreated upon entering the Explode-Render-Animate application and the only occurrences shown are those used in the scene.

- You will modify the properties on Polished Japanese oak and reapply it to the parts. Right-click the material Polished Japanese oak and click Edit Definition.

- Change the trunk direction to 0, 1, 0.

- Now you will modify the glass parameters to allow more light to pass through. On the Sessions Entities page, right-click the material Clear (Glass) (2), and then click Edit Definition.
In the Material Editor dialog box, click the Reflectance tab and set the transmission factor to 1.30. Click OK to dismiss the dialog box.
Activity: Rendering an assembly

- You will change the view to a perspective view. On the ribbon, choose View tab→Style group→Perspective.

Choose Home tab→Render group→Scene.

Step 4

You will now replace the tread plate scene with textures created in the Draft Environment. The textures are JPEG format images that have been assigned to faces of parts in the same manner as the numbers you previously placed on the clock. Since you know how to do this, there is no need to for you to do those steps. To see the textures, you will turn off the tread plate and show the textured parts and then render and save the final image.

- In PathFinder, click the Predefined Archives tab.

- Drag Scenery→No Scenery into the rendered scene.

- The parts wall1.par, wall2.par and wall3.par are hidden. Find them in assembly PathFinder and show them.
• Render the scene.

• You will now save the rendered view as a presentation quality image. Click the Application button and then choose Save As → Save As Image. Set the file type to JPEG and then click the options button. Set the alternate view style to presentation view style. Set the resolution to 300 DPI. Set the units to Pixels. Click OK and then save the file as *Japanese oak Clock.jpg* in the folder containing the documents for this activity.

**Note**

From the Predefined Archives, you have taken rendering parameters and materials and applied them to a rendered scene. There are many combinations and modifications that can be made to enhance the rendered scene that were not covered. The workflow for using the predefined parameters and then modifying them is the same as covered in this activity. You may want to continue experimenting with the Predefined Archives by using other backgrounds, environments, foregrounds, light studios, materials, render modes and scenery not covered in this activity.
Activity: Rendering an assembly

- Click the Application button and then click Save.

- Click Close ERA to exit the Explode-Render-Animate application.

- Save and close the assembly. This completes this activity.

Activity summary

In this activity you learned how to generate presentation quality images of a Solid Edge assembly. In the activity, the following topics were covered:

- Creating and editing backgrounds for rendered scenes.
- Creating and editing light sources for rendered scenes.
- Assigning predefined material textures to parts within an assembly.
- Editing the material properties to give the desired result in the rendered scene.
- Placing and then editing predefined scenery to enhance the rendered scene.
- Saving presentation quality JPEG images once the desired rendering options have been finalized.
Activity: Creating a motor

Step 1
You will open an assembly, inspect and change the rotation units for the assembly and assign a motor to a part in the assembly. Once the motor is defined, a simulation of the motor will be generated to be later used in an animation.

Note
A motor can only be assigned to a part that is under constrained in an assembly. If the under constrained part used to define the motor exists in a subassembly, then the subassembly will have to be made into an adjustable assembly rather than a rigid assembly. By making a subassembly adjustable, the relationships used to position the parts in the subassembly are promoted into the higher level assembly and solved at that level.

You will set the units for Angular Velocity to revolutions per minute.
- Open the assembly motor.asm with all the parts active.
- Click the Application button and then choose Properties→File Properties.
Click the Units tab, and on the Units page, click Advanced Units. Set the Angular Velocity to rpm, and then click OK to dismiss the advanced units settings. Click OK to return to the assembly.
Step 2

You will create the motor and define the motor's parameters.

- In the PathFinder, right-click the part G05_62.par and then click Show Only. Click Fit to see the gear.

Note

As an option, to better understand how the predefined gear relationships in this assembly, there is a spreadsheet located in the same location as the assembly named clock_gears.xls. This spreadsheet shows the relationships and gear ratios used to create the clock mechanism.

- Choose Home tab→Assemble group→Motor.

- Set the motor type to Rotation.

- Set the rotation rate in rpm by entering 1/60.
Activity: Creating a motor

- Select the gear as the under-constrained part.

- Select the interior cylindrical face to define the rotation axis.
• The rotation is defined as counterclockwise as shown. The direction can be flipped by clicking Flip direction before clicking Finish.

• Click Finish to complete the motor definition.

Step 3

This step is to show how to edit the motor parameters defined in the previous step, even though the motor is defined correctly. Once you have defined a motor, you can change a parameter if you need to by editing the motor. You will ensure that the direction of rotation for this motor is counter clockwise. If not, you will reverse the rotation.

• On the ribbon, click the Select command and select Motor 1 in PathFinder.
Activity: Creating a motor

- The rotation will be displayed. If the rotation is counter clockwise as shown, skip the next step.

- To change the direction of rotation, click Edit Definition. Click the Flip Direction button, then click Finish.

Step 4

Now you will simulate the motor. To best see the results, all the parts of the assembly will be shown, and then some will be hidden.

- Click the Select command and right-click motor.asm in PathFinder. Click Show All.
• Using the same procedure as in the previous step, hide \textit{m\_housing.asm}, and then fit the assembly.
Step 5

Now you will create a motor simulation.

- Choose Home tab→Assemble group→Simulate Motor.

- In the Motor Group Properties dialog box, set the Duration as 180 seconds (3 minutes) and the other values as shown, and then click OK.

Note

If you need to change any of these values at a later time, right-click Motors in the time line and then click Edit Definition. You can define multiple motors in a simulation but for this activity, you will just define a single motor.
• The controls for playing the animation are shown below.

![Speed: 1x](image)

• Click Play to start the animation.

![Play](image)

• As the animation is playing, increase the Speed to 4x.

![Speed: 4x](image)

**Note**

Changing the speed to 4x is for animation display purposes only. The motor is still spinning at the assigned rpm.

• Click the Stop button to halt the motor simulation.

![Stop](image)

• Click Go to Start, to reset the animation to the initial point.

![Go to Start](image)

• Set the Speed back to 1x.

• Click the Application button.

![Application](image)

• Click Save. When prompted to save changes to the animation editor, click yes.

• In PathFinder, right-click *motor.asm* and click Show All.

• Save and close this assembly. This completes this activity.
Activity summary

In this activity, you learned how to create and simulate a motor. The motor animation created will be used later during the explode sequence. In the activity, the following topics were covered:

- The speed and direction of a rotational motor was defined.
- Parameters used to define the motor were changed by an editing process.
- The motor simulation was created and run.
- Animation controls and time line were introduced.
- A motor time line was created to be used in exploding and an animation.
Step 1

In this activity you will open an assembly and enter the Explode-Render-Animate application. You will use the auto explode command to create an exploding time line used to animate the explosion. Once the initial explosions are created, you will use the manual explode command to group parts and subassemblies, and to sequence the explosion and define the behavior of the parts as they explode.

You will enter the Explode-Render-Animate application and explode the assembly using the auto explode command. You will explode the assembly with the bind subassemblies option set. After the command is finished, you will examine the results and then use the Unexplode command to reset the assembly.

**Note**

When using the Auto Explode command, the results are dependent on several factors. Relationships used in building the assembly determine how the Auto Explode command behaves. Parts positioned with an axial align will explode away from the adjacent part in the direction of the axis. The same parts that can be positioned with an axial align, can also be positioned with mate, and planar align, however how these parts explode using the auto explode command may not be as desired.

The behavior of subassemblies using the Auto Explode command can be defined. Subassembly parts can be bound together as a group causing it behave as if it is a single part, or the subassembly can be exploded into its constituent parts.

For the Auto Explode command to give desirable and predictable results, you must consider which relationships to use during the process of positioning parts in the assembly.
Activity: Exploding an assembly

- Open the assembly `explode.asm` with all the parts active.
- In PathFinder, observe the relationships and grouping of parts in subassemblies that were used to create the assembly. These relationships and subassemblies will be used in the auto explode command.
Activity: Exploding an assembly

- On the ribbon, choose Tools tab→Environments group→ERA.

- On the ribbon, choose Home tab→Explode group→Auto Explode.

- On the Auto Explode command bar, select Top level assembly, and then click the Accept button.
Activity: Exploding an assembly

- Click Automatic Explode Options.

- In the Automatic Explode Options dialog box, select Bind all subassemblies. Set the Explode Technique to By subassembly level and click OK.

- On the command bar, click Explode, and then click Finish. The results are shown.

Examine the results. The parts that were in the top level of the assembly exploded, and the subassemblies stayed intact.
Activity: Exploding an assembly

- Click the Explode PathFinder tab and observe the grouping. The display shows that the subassemblies are bound and behave as if they were a single part.
Activity: Exploding an assembly

- Expand some of the parts and observe the offset values. The Explode PathFinder allows you to modify events and parameters that define the explosion.

![Diagram of exploded assembly with parts and events listed]
Activity: Exploding an assembly

- Select Group 2 in the Explode PathFinder, and in the command bar enter 15 mm for the explode Distance, and then press enter. This will set a uniform explosion distance.

| Distance: | 15.00 mm |

Note

If you exit the Explode-Render-Animate application, or use the Unexplode command to collapse the explosion without saving a display configuration, any information about the explosion will be lost.

- Choose the Home tab→Configuration group→Configurations command.

- Click New to create a new configuration, and enter exp01, and then click OK. Click Close.

- Click the Unexplode command to restore the assembly to the unexploded state. When asked to delete the current explosion, click Yes.
Activity: Exploding an assembly

Step 2

You will explode the assembly with the bind subassemblies option turned off.
- Click the Auto Explode command.

- Select Top-level assembly and then click the Accept button.

- Click the Automatic Explode Options button.

- Turn off Bind all subassemblies and click OK.
Activity: Exploding an assembly

- Click Explode, and then click Finish. The results are shown.

Examine the results. All the parts exploded as if they were in the top level assembly.

- Click the Configurations command.

- Click New to create a new configuration, and enter exp02, and then click OK. Click Close.

- Click the Unexplode command to restore the assembly to the unexploded state. When asked to delete the current explosion, click Yes.
Step 3

You will bind the clock hand subassemblies so that they don’t explode, and repeat the Auto Explode command.

- In PathFinder, select the subassemblies defining the clock hands.

- On the Explode group→Bind command.

- Notice the display in PathFinder has changed to indicate the subassemblies are bound.

Note

If you need to unbind a subassembly, select the subassembly and click the Unbind command.

- Repeat the Auto Explode command with Bind all subassemblies turned off.
Activity: Exploding an assembly

- Click Explode, and then click Finish. The results are shown.

Examine the results. All the parts exploded as if they were in the top level assembly except the clock hands.
Activity: Exploding an assembly

- You will reposition the parts e_glass.par and e_SE_face.par in the explosion. Choose the Explode group→Reposition command.

- Select e_glass as the part to reposition.
Activity: Exploding an assembly

- Select G07_60_15.par as the part to place the part next to.
Select the side away from the clock housing to place the part.

Note

The flow line retains its length and may be longer than desired.
Activity: Exploding an assembly

- Reposition the part e_SE_face.par by repeating the steps above. The part to place the part next to will be e_glass.par. The direction is towards the clock body. This positions the face between the glass and the rest of the clock.
Activity: Exploding an assembly

- Click the Select command and in the Explode PathFinder, find e\_glass.par and e\_SE\_face.par and set the offset distance to 30 mm.

```
Distance: 30.00 mm
```

- Click the Configurations command.

- Enter exp03, and then click Save. Click Close.

- Click the Unexplode command to restore the assembly to the unexploded state. When asked to delete the current explosion, click Yes.

Step 4

You will use the Auto Explode command with the subassembly option set. This will be the first step in creating the final explosion. After the auto explosion, you will use the manual Explode command to further control the events making up the explosion.

- Click the Auto Explode command.

- On the Auto Explode command bar, select Subassembly. Select e\_housing.asm, and then click the Accept button.
• Click the Automatic Explode Options button.

• Select Bind all subassemblies. Set the Explode Technique to By subassembly level and click OK.

• Click the Automatic Spread Distance button and enter a value of 15 mm.
Activity: Exploding an assembly

- Click Explode, and then click Finish. The results are shown.

Examine the results. Only the subassembly chosen exploded.

Step 5

You will now use the manual Explode command to refine the explosion events.
- Choose Home tab→Explode group→Explode.
In PathFinder, in the subassembly e_housing.asm, select e_feltpad.par, and then click Accept. This part is on the bottom of the housing and is positioned using a ground relationship. You will explode it in the same direction as the foot pads.
Activity: Exploding an assembly

- Select the e_case.par as the stationary part.
Activity: Exploding an assembly

- Select the bottom face of e_case.par as the stationary part face to explode from.
Activity: Exploding an assembly

- Select down as the direction to explode.
Activity: Exploding an assembly

- Set the offset distance to 35 mm and then click Explode. Click Finish.

Step 6

Using the manual Explode command, you will move the gears as a group. Gears will be placed between the clock housing and the circular back plane that is used to position the gears in the clock. You will first need to correct the spread distance between the housing and the back to make room for the gears.

- In the Explode PathFinder, select the Event 1 in e_back.par and change the distance to 60.00 mm

- Click the manual Explode command.
Activity: Exploding an assembly

- In PathFinder, select all the gears and the subassemblies that define the clock hands, and then click Accept.

- Select e_back.par as the part to remain stationary.
Select the circular face shown as the stationary face from which to explode.
- Select the direction shown as the explosion direction.
• Set the parameters shown.

Explode Options

- [ ] Move components as a unit
- [ ] Spread components evenly

Explode order:

- G15_30_15.par:1
- G11_75_15.par:1
- G14_30_15.par:1
- G05_52.par:1
- G12_30_20.par:1
- G07_60_15.par:1
- hour.asm:1
- G04_56_18.par:1
- G03_50_15.par:1
- G02_52_15.par:1
- minute.asm:1
- G01_34_15.par:1
- second.asm:1

- [ ] Show this dialog when entering the Explode Step

[OK] [Cancel] [Help]
Activity: Exploding an assembly

- Enter a distance of 25 mm and then click Explode, and then click Finish.

- Click the Configurations command.

- Click New, and enter exp04. Then click OK. Click Close.

**Note**

You will overwrite this configuration at a later time. It is good practice to incrementally save the exploded views in case you need to revert back to the point at which you saved.
Step 7

You will use the move exploded part command to reposition a portion of the explosion.

- Choose Home tab→Explode group→Drag Component.

- From the Explode PathFinder, select e_back.par, and then click Accept on the Drag Component command bar.

- On the command bar, select Move.
Activity: Exploding an assembly

- Drag the Z axis vertically.
Activity: Exploding an assembly

- Position the parts as shown.
• The result is shown.

• Choose the Select command, and in the Explode PathFinder, select the event you just created. The vertical flow line will highlight. Set the distance to 50 mm, and then click OK.

• Click the Drag Component command.
Activity: Exploding an assembly

- Select `e_backplate.par`, then click accept.

- On the command bar, select rotate.
Activity: Exploding an assembly

- Enter 45° as the angle to rotate about the Y axis. The results are shown.

- In the Configuration group on the ribbon, click Save Display Configuration.

**Note**

The Save Display Configuration command saves the changes to the configuration name that is currently displayed on the ribbon. This is a quick way to save a configuration.
Step 8

You will now animate the explosion.

**Note**
Creating an animation of an exploded view is the only portion of the animate command covered in this activity.

- Choose Home tab→Animate group→Animation Editor.

- Examine the Animation Editor.
  The right pane is the time line for each of the animation events. A motor has been previously defined in this assembly. Controls for playing the animation are displayed.

The left pane displays the animation events, and the right pane displays the event duration bars. These can be used to define and sequence the events of the animation.

- Click Animation Properties.
Activity: Exploding an assembly

- Set the values as shown, and then click OK.

![Animation Properties window](image)

- Right-click the Explosion event, and then click Edit Definition.

![Edit Definition option](image)
Activity: Exploding an assembly

- Set the parameters as shown.
  - Initial State: Exploded.
  - Speed: Explosion duration 5 seconds per event.
  - Animation Order: Innermost first.

![Explosion Properties dialog box]

Click OK.

- The explosion events are populated in the left pane.

  Note
  During an animation, you can zoom and pan. It is good practice to arrange the display window before the animation to fit the animation in the view. To do this, choose the View tab→Window group→Arrange, and then choose Horizontal from the dialog box.

- Click Play on the animation controls and observe the explosion.

![Play button]

- When the explosion is complete, click Stop on the animation controls.

![Stop button]

- Click Go to Start on the animation controls.

![Go to Start button]
Activity: Exploding an assembly

- Now you will change the sequence of the explosion. Right-click the explosion event, and then click Edit Definition.

  ![Explode Panel](image)

- Set the parameters as shown.
  - Initial state: Collapsed.
  - Animation order: Innermost first.

  ![Explode Properties](image)

  Click OK.

- Click Play on the animation controls and observe the explosion.

  ![Play Button](image)

- When the explosion is complete, click Stop on the animation controls.

  ![Stop Button](image)
• Click Go to Start on the animation controls.

• Now you will change the sequence of the explosion. Right-click the explosion event, and then click Edit Definition.

• Set the parameters as shown.
  • Initial state: Collapsed.
  • Animation order: Outermost first.

Click OK.

• Click Play on the animation controls and observe the explosion.
Activity: Exploding an assembly

- When the explosion is complete, click Stop on the animation controls.

- Click Go to Start on the animation controls.

- To exit the Animation Editor, click the Animation Editor command again. Click Yes to save the changes to the current animation.

Step 9

To get all the fasteners to explode at the same time, you will move all the fasteners into the same event group for animation purposes.

- In the Explode PathFinder, select the fasteners connecting the footpads to the bottom of the case. Right-click and select Remove from Event Group.

\[\text{Note}\]

The event group that contained these fasteners was dissolved because it no longer contains any events.

- Right-click the fasteners and select Add to Event Group.
Activity: Exploding an assembly

- Either from Explode PathFinder or in the graphics window, select a fastener in the group you are adding these fasteners to.

- The fasteners now all belong to the same event group.

- Click the Animation Editor command to close the editor.

- Click Save Display Configuration.
Step 10

You will replay the animation and observe the behavior of the fasteners now that they are all in the same event group.

- Click the Animation Editor command.

  ![Animation Editor](image)

- Update the animation with the configuration changes.

Changes have been made to the configuration "exp04" since the animation "Animation_1" was last saved. Do you want to:
- [ ] Update the animation with configuration changes (this will result in the loss of explode event changes to the animation)
- [ ] Ignore the configuration changes (you will be prompted again next time)
- [ ] Break the link between the animation and the configuration.

- Click Play on the animation controls and observe the explosion.

  ![Play Animation](image)

- When the explosion is complete, click Stop on the animation controls.

  ![Stop Animation](image)

- Click Go to Start on the animation controls.

  ![Go to Start](image)

  **Note**

  Notice the fasteners exploded simultaneously.

Step 11

You will add a motion path the explosion to control movement of the bottom fasteners.

- Click the Motion Path command on the animation controls.
• Select the bottom fasteners as the components that will follow the motion path, and then click Accept.

• Press X on the keyboard as many times as it takes to lock the XY plane as shown.

• On the command bar, enter 35 as the frame count.
Activity: Exploding an assembly

- Enter the curve approximately as shown and Accept. Click Finish.

![Animation Diagram]

Note
This curve is a free-form 3D space curve locked into the XY plane. Your results may vary slightly.

- Play the animation. Notice the fasteners follow the motion path at the beginning of the animation.
- In the animation time line, drag the motion path event bar to the right as far as it can go.
- Right-click the event bar and check the properties. These can be modified if necessary.
- Run the animation from the beginning. Notice the fasteners follow the motion path at the end of the animation rather than the beginning.
- Stop the animation and reset to the beginning. Save the changes by clicking the Save Animation command.
- To exit the Animation Editor, click the Animation Editor command.
This completes the activity. Click Close ERA to exit the Explode-Render-Animate application. Save the assembly.

Activity summary

In this activity, you used the Explode-Render-Animate application to explode an assembly. You accomplished the following:

• Used the manual explode command to order and sequence the events of an explosion.

• Defined the distances and directions of exploding parts along a time line.

• Grouped parts and subassemblies and controlled how they behave during and explosion and when they explode.

• Created an animation time line to be used in an animation sequence.

• Used the Auto Explode command to begin an exploding sequence.
D  Activity: Animating an assembly

Step 1

In this activity you will open an assembly that contains a motor and an exploded configuration. You will use the Animation Editor to manipulate the events that occur during the animation. You will create an animation that consists of camera movement, changes in part appearance, part motion paths, exploded views and motion from motors.

You will define a camera path for a predefined animation.

**Note**

The description of the animation controls is also covered in the activity exploding an assembly.

- Open the assembly `animate.asm` with all the parts active.
- Choose Tools tab→Environs group→ERA.
- Choose Home tab→Animation group→Animation Editor.
Activity: Animating an assembly

- Examine the Animation Editor.
  The right pane is the timeline for each of the animation events. A motor has been previously defined in this assembly. Controls for playing the animation are displayed.

The left pane displays the animation events, and the right pane displays the event duration bars. These can be used to define and sequence the events of the animation.

- Click Animation Properties.

- Set the values as shown, and then click OK.
• Right-click the Explosion event and then click Edit Definition. Examine the parameters previously defined for this explosion. Click OK when finished.

![Explosion Properties](image)

• Click the Camera Path command to open the Camera Path Wizard.

![Camera Path Wizard](image)

• Set the values as shown, and then click Next.
Activity: Animating an assembly

- Click Preview. Observe the animation preview, and then click Finish. The camera path is created.
Step 2

You will view the camera path and then edit the path.

- Click the Show Camera Path command. The path is displayed.

- Right-click the camera path in the event time line, and then click Edit Definition.
Activity: Animating an assembly

- On the command bar, click the Draw Path Step group button and observe the controls.

  Name: Camera Path

- The camera path can be either open or closed. For this path click Closed.

- The key points of the camera path are graphically displayed as points on the curve. The X-Y-Z axis displays at the location of the key point which is currently being edited and a preview of what the camera sees at that frame is shown. The frame count showing the duration of the camera movement is displayed.

  Frame count: 305
Activity: Animating an assembly

- Camera movement and direction can be edited at each key point. The blue navigation arrows will move to the next or previous point for making changes to those points. Click the Next Point command, which is the right blue arrow.

Notice the camera preview and X-Y-Z axis moves to the next point.
Click the Straight Path command. This changes the curvature of the previous point from a curve to a straight path.
Activity: Animating an assembly

- Click the Next button twice to move the camera.

- Click Hold. This will freeze the animation until the next key frame is reached in the time line.
Activity: Animating an assembly

- Click the Next button once. Drag the tangency control handle of the key point.

- Drag the handle so that the curve is approximately positioned as shown.
• Click next point. Select the X axis of the triad and enter a rotation angle of 5°.

• Select the origin of the triad. The curvature tangency handles are available at the key point.
Activity: Animating an assembly

- Drag one of the handles so that the curve is approximately modified as shown.

- Click Finish. Play the animation and observe how the edits to the camera path affected the animation. After the animation plays, reset the animation by stopping the animation and then clicking the Go to Start command.

- On the camera path event bar, notice the key points are displayed as green graduation marks. Click and drag any of the key points to a different position. This changes the time at which a key point occurs, and increases the speed of the transition from that key point to the key point in the direction you moved the point. Likewise, the duration of the transition of the camera path is increased from the key point moved and the point you moved away from.

- Play the animation and observe how the edits to the camera path affected the animation. After the animation plays, reset the animation by stopping the animation and then clicking the Go to Start command.

Step 3

You will add an appearance event to the time line.

- Click the Appearance command.
Activity: Animating an assembly

- Select a_case.par and a_backplate.par as the parts for the appearance change, and then click Accept.

- Set the Start style to Use Part Style and the Finish style to Chrome. Set the frame duration to 50, then click Accept. Click Finish.

- Find the appearance and play the animation from the beginning through the first 50 frames. Observe the change to chrome for the parts selected.

- Play the animation and observe how the selected parts transition to chrome. After the animation plays, reset the animation by stopping the animation and then clicking the Go to Start command.

Step 4

You will now edit the event bars along the time line.

Note

An event group consists of events occurring either simultaneously or sequentially. The duration of an event group is defined by the extent of all the events within that group. Actions such as mirroring and copying of events must incorporate all the events making up a group.

- Right-click the Appearance_1 event bar and then click Properties. Examine the values, then click OK.

  Note

  The values can be edited in the Duration Properties dialog box if desired.

- Click and drag the right side of the Appearance_1 event bar to frame 100.
Activity: Animating an assembly

- Right-click the Appearance_1 event bar and then click Properties as you did previously. Notice the changed values.

![Duration Properties](image)

- Right-click the Appearance_1 event bar and then click Copy.

![Cut Copy Paste](image)

- Right-click on the time line after the Appearance_1 event and then click mirror.

![Cut Copy Paste Mirror](image)
Step 5

In the following steps, you will use what you learned in the previous steps to continue editing the animation. You will not be directed to edit specific events however you will edit events you choose based on the general directions given.

- Lengthen an explode event by dragging the end of the event bar for that event.
- Copy and mirror the explosion event.
- Reposition an explosion event that has a sequence of cascading events. Shorten some of the events and lengthen others.
- Generate a new camera path based on saved views.

Step 6

You will save an animation.

Note

Animations are saved as .avi formatted movies. There are many different players available from many different sources. A video codec is a device or software that enables video compression and or decompression for digital video. The list of codecs that are available to be used for creating an animation may differ from one computer to the next. To choose the codec which best works for the animations you are trying to create will need to be determined by experimentation.
Activity: Animating an assembly

- Animation views can be generated from previously generated 3D view styles. To see the current 3D view styles available, choose View tab→Style group→Styles.

- Set the Style type to 3D View Styles.

![Style dialog box](image)

**Note**
Existing 3D view styles can be modified or new 3D view styles can be created to suit your needs.

- Click Apply to close the Style dialog box.
- Reopen the Animation Editor in Explode-Render-Animate.
- Reset the animation to the beginning. Click the Save as Movie command.
• In the Save As Movie dialog box, click options.

![Save As Movie dialog box](image-url)
Examine the options for creating an animation.

![Save As Movie Options dialog box](image)

**Note**

Creating an animation can take considerable system resources depending on the options chosen. It is good practice to run a small number of frames rather than the complete animation to preview the results. Once the settings are satisfactory, then you can run the complete animation.

Notice the view style selection set is the same as the 3D view styles shown in the previous steps.

Set the quality to 100, and click OK.

- Save an animation to a folder of your choice and give it a name of your choice.

  **Note**

  To create a rendered animation, render the view just prior to saving the animation and the animation will use the rendering settings. Rendered animations typically take more processing time to create.
Activity: Animating an assembly

- To exit the Animation Editor, click the Animation Editor command.

- This completes the activity. Click Close ERA to exit the Explode-Render-Animate application. Save the assembly.

Note

To create a rendered animation, render the view just prior to saving the animation and the animation will use the rendering settings. Rendered animations typically take more processing time to create.

This completes this activity. Save and exit the assembly.

Activity summary

In this activity, you learned how to create and edit an animation. The animation consisted of events defined by exploded views, camera movement, appearance events, and rendering. Using editing commands, the time line for each event was able to be edited to produce the desired effect. You created an .avi movie showing the animation.